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Terminology

MSOP Main data Stream Output Protocol

DIFOP Device Info Output Protocol

UCWP User Configuration Write Protocol

Azimuth Horizontal Angle of LIDAR

Timestamp Time Point of Encapsulation of a UDP Packet
Header The Header of a UDP packet

Tail The Tail of a UDP packet
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Congratulations on your purchase of a RS-Bpearl Real-Time 3D LiDAR Sensor. Please
read carefully before operating the product. Wish you have a pleasurable product
experience with RS-Bpearl.

1.

Safety Notice

In order to reduce the risk of electric shock and to avoid violating the warranty, do not
open sensor housing.

Laser safety - The laser safety complies with IEC60825-1:2014.

Read Instructions - All safety and operating instructions should be read before
operating the product.

Follow the Instructions - All operating and use instructions should be followed.

Retain Instructions - The safety and operating instructions should be retained for
future reference.

Heed Warnings - All warnings on the product and in the operating instructions should
be adhered to.

Maintenance - The user should not attempt to maintain the product beyond what is
described in the operating instructions. All other Maintenance should be referred to
RoboSense.
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2. Introduction

RS-Bpearl, the close-range LiDAR developed by RoboSense, is the world leading LiDAR
for monitoring blind spot. It is particular utilized in and perception of environment for
autonomous driving.

RS-Bpearl is realized by solid-state hybrid LIiDAR. The technical details are listed below:
Minimum measuring range: 10 cm

Accuracy: within up to + 2 centimeter

Data rate up to 576,000 points/second

Horizontal field of view (FOV) of 360°

Vertical field of view (FOV) of 90°

12vDC
Figure 1:Representation of RS-Bpearl Imaging.
The operating Instructions of LiDAR:
® Connecting the device of RS-Bpearl;
® Parsing the data packets, in order to capturing the values of azimuth, measuring
distance and calibrated reflectivity;
® Calculate X, Y, Z coordinates from reported azimuth, measured distance, and vertical
angle;
® Storing the data of point cloud according to demand;
® Checking the status of set-up information of device;
® Resetting the status of network configuration, timing and rotation speed according to
demand.
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3. Product Specifications'’

Table 1: Product Parameters.

TOF measuring distance, including the reflectivity

Range: from 0.1 m to 30m (Reflectivity: 10%)?

Accuracy: +3cm (typical value)?

FOV(vertical): 90°

FQOV (horizontal): 360°

Angle resolution (horizontal/ azimuth): 0.2° (10 Hz)/0.4° (20 Hz)
Rotation speed: 600/1200 rpm (corresponding to 10/20 Hz)

Sensor

Class 1
Wave length: 905nm
Full angle of beam divergence: horizontal 9 mrad, vertical 17.8 mrad

Laser

Date rate: ~600k points/second

100M Ethernet

Communication protocol: UDP

The Information that is included in Dates Segment:
Distance
Rotation angle/Azimuth Calibrated

reflectivity
Synchronized timestamp (Timer resolution 1 us)

Output

Power consumption: 13 W(typical)*

Working voltage: 9-32 VDC

Weight: 0.92 kg (without cable)

Dimensions: Diameter 100 mm x Height 111 mm
Ingress Protection Rating: IP67

Operation temperature: -30 ‘C~+60 C°

Storage temperature: -40 ‘C~+85 C

Mechanical/
Electrical/
Operational

' The following data is only for mass-produced products. Any sample, testing machine and other
non-mass-produced versions may not be referred to this specification. If you have any questions, please
contact RoboSense sales.

2 The measurement target of range is a 10% NIST Diffuse Reflectance Calibration Targets, the test
performance is depending on circumstance factors, not only temperature, range and reflectivity but also
including other uncontrollable factors.

3 The measurement target of accuracy is a 50% NIST Diffuse Reflectance Calibration Targets, the test
performance is depending on circumstance factors, not only temperature, range and reflectivity but also
including other uncontrollable factors.

4 The test performance of power consumption is depending on circumstance factors, not only
temperature, range and reflectivity but also including other uncontrollable factors.

5 Device operating temperature is depending on circumstance, including but not limited to ambient
lighting, air flow and pressure etc.
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4. Interface

4.1 Power Supply

A voltage transform module is already integrated in RS-Bpearl. The supply voltage could
keep in the range of 9~32 VDC with utilization of Interface-Box. The recommend supply
voltage is 12 VDC. The operating power consumption is about 13 W (typical).

4.2 Data Output interface of LiDAR

The data output access of RS-Bpearl is physically protected by an aviation terminal
connector. From the LiDAR to the aviation connector the cable length is 1 meter. The pins
of the aviation terminal connector are defined as follow:

= [l
m
PIN Wire Color Function
1 Red +12V
2 Yellow +12V
3 White GROUND
4 Black GROUND
5 Green GPS PULSE
6 Blue GPS REC
7 Brown LiDAR Ethernet RX+
8 Brown white LiDAR Ethernet RX-
9 Orange LiDAR Ethernet TX+
10 Orange white LiDAR Ethernet TX-

Figure 2: Aviation Connector PIN Number.

4.3 Interface Box

In order to connect the RS-Bpearl conveniently, there is an interface box provided.

There are accesses for power supply, Ethernet and GPS on Interface Box. Meanwhile
there are also indicator LEDs for checking the status of power supply.

For those accesses, an SH1.0-6P female connector is the interface for GPS signal input.
Another interface is a DC 5.5~2.1 connector for power input. The last one is a Rj45
Ethernet connector for RS-Bpearl data transport. The length of the integral cable is 3 m,
when the cable length needs to be shorten or extended, please contact RoboSense
technical support, as shown in Figure 3.
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_Power Qutput Integral Cable

PIN Function
1 GPS PULSE
2 +5V

3 GND
4

5

GPS REC
GND

6 NC

Figure 3: Interface Definition Interface Box.
Note: When RS-Bpearl connects its grounding system with an external system, the
external power supply system should share the same grounding system with that of the
GPS.

When the power input is in order, the red LED which indicates the power input status will
be lighted. Meanwhile the green LED which indicates the power output status will be
lighted, when the power output is in order. While red LED is bright and green LED is dark,
Interface Box is in Protection status. While red and green LEDs are all dark, please check
whether the power supply is out of order or damaged. If it is intact, that could prove that
the Interface Box is damaged. Please send the damaged Interface Box back to
RoboSense Service.

GPS interface definition: GPS REC stands for GPS input; GPS PULSE stands for GPS
PPS input.

Interface of power supply is standard DC 5.5-2.1 connector.
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4.4 Connection of Interface Box

> .

A

Power Adapter

ey [ 1L WP

1 " i Connect to GPS sync module(Optional)

= - .
1 Insertaseboy —

. Connect to PC through the host |
s * Ethernet Port (
B e e e 3

Figure 4: Diagram of Interface Box Connection.
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5. Communication Protocol

RS-Bpearl adopts IP/UDP protocol and communicates with computer through Ethernet. In
this User Guide, The UDP protocol packet in this manual is of 1290 byte long and consists
of a 1248-byte valid payload and a 42-byte header. The IP address and port number of
RS-Bpearl is set in the factory as shown in the Table 2, but can be changed by the user as

needed.
Table 2: The IP Address and Port Number Set in the Factory.
Device IP Address MSOP Port No. DIFOP Port No.
RS-Bpearl 192.168.1.200
6699 7788
PC 192.168.1.102

The default MAC Address of each RS-Bpearl is already set up in the factory with
uniqueness. In order to establishing the communication between a RS-Bpearl and a
computer, the IP Address of the computer should be set at the same network segment.
For instance, IP Address is 192.168.1.X (X can be taken by a value from 1~254), subnet
mask: 255.255.255.0. If the internet setting of the sensor is unknown, please set the
subnet mask as 0.0.0.0, connect the sensor to the computer, and capture UDP packet to
get the information of IP and Port through Wireshark.
RS-Bpearl adopts 3 kinds of communication protocols to establish communication with the
computer:
» MSOP (Main Data Stream Output Protocol). Distance, azimuth and reflectivity
data collected by the sensor are packed and output to computer;
» DIFOP (Device Information Output Protocol). Monitor the current
configuration information of the sensor;
» UCWP (User Configuration Write Protocol). User can modify some

parameters of the sensor as needed.
Table 3: Overview of the MSOP.

Protocol Abbreviation Function Type Size Interval
Main data Stream Output Protocol MSOP Scan Data Output UDP | 1248 bytes | ~0.66 ms
Device Information Output Protocol DIFOP Device Information Output | UDP | 1248 bytes | ~100 ms
User Configuration Write Protocol ucwp Sensor Parameters Setting | UDP | 1248 bytes INF

Note: In the following chapters only the valid payload (1248 byte) will be discussed.

5.1 MSOP

MSOP is the abbreviation of Main Data Stream Output Protocol. I/O type: device output
data, computer parse data.

Default port number is 6699.

MSOP outputs data information of the 3D environment in packets. Each MSOP packet is
1248 bytes long and consists of reported distance, calibrated reflectivity values, azimuth
values and a timestamp.

In each RS-Bpearl MSOP packet, payload is 1248-byte long and consists of a 42-byte
header and a 1200-byte data field containing twelve blocks of 100-byte data records and a
6-byte tail. The basic data structure of a MSOP packet for single return is as shown in
Figure 5:
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42 byte
{21~30
stamp)

Data block1

MSOP Packet (1248 byte)

data packet

12*100byte= 1200byte

Data block 2

Data blockn

Data bloc

Oxffee Oxffee 0xffee Oxffee
Azimuth 1 Azimuth 1 Azimuth 6 Azimuth 6
channeldata 1 channel data 1 channel data 1 channeldata 1
channel data 2 channel data 2 channel data 2 channel data 2
channel data ... channel data .. channel data ... channel data ...
channel datal6 channel data 16 channeldata 16 channel data 16
channeldatal7? channel data 17 channel data 17 channeldata 17
channel data 18 channel data 18 channeldata 18 channeldata 18
channel data ... channel data .. channel data ... channel data ...
channel data 31 channel data 31 channel data 31 channeldata 31
channel data 32 channel data 32 channeldata 32 channel data 32

Figure 5: Single Return MSOP.
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The basic data structure of a MSOP packet for dual return is as shown in

Figure 6.

MSOP Packet (1248 byte)

data packet
12*100byte= 1200byte

Data block 2

Data blockn

Datablock 12

Oxffee Oxffee 0xffee Oxffee
42 byte
(21~30 Azimuth 1 Azimuth 1 Azimuth 6 Azimuth 6
=‘tm“]ﬂ channeldata1 channel data 1 channel data 1 channel data 1
channel data 2 channel data 2 channel data 2 channel data 2
. channel data ... channel data .. channel data ... channel data ...
First '
return
channel data 16 channel data 16 channeldata 16 channel data 16
channeldata17 channel data 17 channel dats 17 channeldata 17
channel data18 channel data 18 channeldata 18 channeldata 18
Second
return —l channel data .. channel data .. channel data ...
channel data 31 channel data 31 channeldata 31 channel data 31
channel data 32 channeldata 32 channeldata 32 channel data 32

5.1.1 Header

Figure 6: Dual Return MSOP.

The 42-byte Header marks the beginning of data blocks.
In the 42-byte data header, the first 8 bytes are for header identification, the 21st to 30th byte
records timestamp, and the rest bytes are reserved for future updates.
The first 8 bytes of the header is defined as 0x55, OxAA, 0x05, 0x0A, 0x5A, 0xA5, 0x50, 0xAO.
Time stamp with a resolution of 1us records the system time. Please refer to the definition of
time in Appendix B.9 and Table 6 in section 5.3 of this chapter.

6hyte



rcbosense RS-Bpearl User Manual

5.1.2 Data Field

Data field comprises data blocks that contain valid measurement data, in total 1200 bytes.
Each data filed contains 12 blocks, each block is 100-byte long and is a complete
measurement data set. Each data block begins with a 2-byte start identifier “Oxffee”, then
a two-byte azimuth value (rotational angle). Each azimuth value records 32 sets of
channel data reported by the 32 laser channels. (Please see chapter 9 for the relationship
between channel sequence and vertical angel)

5.1.2.1 Azimuth Value
The reported azimuth is associated with the first laser firing in each sequence of laser
firings. The Azimuth Value is recorded by the encoder. The zero position on the encoder
indicates the zero degree of azimuth value on RS-Bpearl. The resolution of Azimuth is
0.01°.
For example, in Figure 8, the azimuth value is calculated through the following steps:

Get azimuth values: 0x61, 0x86

Combine to a 16 bit, unsigned integer: 0x6186 Convert to decimal: 24966

Divided by 100

Result: 249.66°
Hence, the firing angle is 249.66°

5.1.2.2 Channel Data
Channel Data contains 3 bytes, with the upper 2 bytes (16 bits in total) store distance
information, and the lower 1 byte contains reflectivity data. The structure of channel data
is as shown in Table 4.

Table 4: Channel Data Definition.

Channel data n (3 byte)

2-byte Distance 1-byte Reflectivity

Distance1 [15:8] Distance?2 [7:0] Reflectivity Information

The 2-byte distance data is set in centimeter. The distance resolution is 0.5 cm. The
following shows how to parse channel data:
For example, in the case of Figure 8, the distance information is calculated by:

Get distance values: 0x01, Oxb4.

0x01 is the upper byte of distance, concert to decimal: 1.

Oxb4 is the lower byte of distance, convert todecimal: 180.

Hence, distance= upper byte of distance * 256 + lower byte of distance

= 1*256 + 180 = 436.

According to distance resolution, the distance: 435 *0.05 = 2.18 m.

Hence, the measured distance is 2.18 m.

10
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5.1.3 Tall

The tail is 6 bytes long, with 4 bytes unused and reserved for other information, and the
other 2 bytes as: 0x00, OxFF.

5.1.4 MSOP Data Package

The following Figure 8 shows the format of MSOP data packet and relevant parsing
processes.

e mEE fED RRe BRO HE dte SEe FEw TREQ R

AW 5@ TRE ]e== aAag=
DR Cirl=/>
Ha Tine Sourag Dastination Frotocal  Langth  Info
1 9.800000 192.168.1.288 192.168.1.162 uoP 1298 £699+6699 Len-1243
2 B.889EI5 192_168.1.268 192 168.1.182 DR 1298 BE99+6699 Len=1248
3 g.00183L 192.168.1,280 192.168.1.182 uoR 1298 £699+6633 Len=1248
4 9082821 192.168.1. 268 192.168.1.162 unrF 1298 66996699 Len-1248
5 B.802697 192.168.1.280 192.168.1.1682 UoR 1298 6699-6633 Len=1218
5 9.903833 192.168.1.280 192.168.1.182 UoR 1298 66996633 Lan=1298
7 8.864057 192.168.1.288 197 168.1.182 DR 1298 BE99-6639 Len-1248
8 0.004593 1932.168.1.280 192.168.1.1082 DR 1298 56996633 Len=1248
9 8.805392 192.168.1.208 192.168.1.182 uoP 1298 5699+6699 Len-1243
AL 0 RAOERCA 1970 AEH 4 080 1079 A£8 1 1687 Ling 19300 (AT BOD | oe-194

[Frame 6: 1290 bytes on wire (18328 bits), 1299 bytes captured (18320 bits)

+ Ethernet II, Src: Dell 17:4b:84 (80:1c:23:17:4b:04), Dst: LcfcHefe 4b:5F:8c (c8:5b:76:4b:5F:0¢)
+ Internet Protocol Version 4, Src: 192.168.1.2086, Dst: 192.168.1,182

|| © User Datagram Protocol, Src Port: 6699, Dst Port: 6693

cB 5b 76 db 5f Bc @@ 1c 23 17 4b B4 23 22 45 2@
84 fc 98 87 40 0@ 80 11 d9 65 <@ a8 81 cB <@ a8
81 65 1a 2b 1a 2b B4 =8 4b =G 55 3a 85 9= 5= a5
S8 all @0 £@ 08 B8 B0 HA B R B 00 P B8 11 B1
B1 B8 B2 17 82 9c @1 56 B2 @8 0a 88 8O 98 Ba B8
=8 18 58 15 £f e= 61 72 81 b4 3= B1 £7 38 81 b7
38 01 be 30 81 c1 31 81 5 2F 81 cc 36 01 d5 32
81 df 38 81 ea 3b 01 ea 1c 81 c6 1c B1 a5 28 61
8b 22 @1 b1 24 B1 55 1f 61 48 2b B1 3d 29 81 37
1a @1 36 Ba @1 18 86 81 17 B8 Ff £F 81 +F +f 01
ff £f @1 ff ff 01 @@ 87 32 ff ff 3a 8@ 89 19 ff
ff 19 @@ 11 73 20 16 a8 ff ee 61 86 81 b4 3e 81
57 30 @1 b7 38 81 bc 38 B1 cl 39 81 c5 2f @1 cc
31 @1 d5 32 @1 df 31 81 ea 3c @1 29 1c @1 5 1c
21 a5 20 81 3a 22 01 61 24 91 54 1f Bl 48 2b 81
3d 27 @1 37 1e @1 35 Ba 81 1B 056 @1 17 @7 fFf ff
Bl £f £f 8L ff £f @1 ff ff 81 ff £F 2e ff Ff 38
ff FF 19 £f ff 19 @0 11 72 88 16 a8 ff == 61 98
91 bd Je 81 b7 31 81 b7 38 91 bc 38 81 cl 3@ 81
ch 2f 81 cc 31 81 d5 32 81 df 31 81 ea 3b 81 =8
ib 81 c5 1c @1 a4 28 81 Aa 22 @1 6B 24 91 54 28
81 47 Zb 81 3c 27 81 37 1b 81 35 Ba 81 18 86 81
i 17 B8 £Ff FF 01 +f £F 81 £F £ 01 £F £F 01 £F FF
Bl 2e Ff FF 3a ff £f 1d £f fF 19 88 11 71 88 16 a8

Figure 7: MSOP Packet.

11
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HEE RER WEE MgE EEo BEQ FEW TAD FEE

d = & RE g &=

[(NERBridEs ~ Tul
"Hn.. ) Tun. Soxoe Destination Frotocoel
1 @.366600 192,168.1.209 192.168.1.182 P
2 ©.800695 192.168.1.200 192.,168.1.102 UoP
3 @.ga1831 192.168_1.208 192.168.1_182 uopP
4 9.892021 192,168.1.200 192.168.1.102 UoP
5 9.882697 192.168.1.200 192,168.1.102 UDp
6 0.093033 192.168.1.200 192.168.1.102 uoP
7 0.804957 192.168.1.200 197.168.1.102 UDP
8 B.e8dea3 192.168_1.200 1592.168.1.182 uor
9 ©.005392 192.168.1.200 192,168.1.102 UDP
10 8. 686054 192.168.1.200 197.168.1.182 oP
11 0.0886569 192,168.1.209 192.168.1.102 P
12 §.867290 192.168.1.200 193.168.1.102 UDP

Lengih Infs
1298 6699+6699 Len-1248
1298 6699+6689 Len=1243
1298 EE99+66599 Len=-1248
1296 56996659 Len=1248
1298 66996659 Len=1248
1298 6E99-5669% Len-1248
1298 6699-+5509 Len=1248
1298 BE99-6E6599 Len=-1248
1298 6699-+6609 Len=1248
1296 AE99-+6699 Len=1248
129@ 6699+66%9 Len-1248
12968 669956609 Len=1248

b Frame &6: 12928 bytes on wire (183208 bits), 1298 bytes captured (18328 bits)

I Ethernet II, Src: Dell 17:4b:@4 (@@:1c:23:17:4b:04), Dst: LcfcHefe 4b:5F:8¢
Internst Protocol Version 4, Sec: 192 168.1.28@, Dst: 192.168.1 p@d——

v User Datagram Protocol, Src Port: 669%, Dst Port: 6699

Header:0x55,0xaa,0x05,0x0a,0x5a,0xa5, 0x50,0xa0

i Data {1248 bytes)

cB 5b 76 4b S5f Bc B@ 1c 23 17 40 B4 B8 L"E&-‘S Be .{\{K._... =
B4 fc 98 P7 40 PO 83 11 d9 63 B SR B1 A B B .. .@...|.
01 66 1a 2b 13 2b 04 =8 4b 6[55 ca 05 Ba 5a s —Fre K.U.
S0 20 60 PO 60 PO 09 0O 00 £0 00 00 B0 09 11 Bl P,
01 00 02 17928 01 56 02 00 G2 00 @9 00 89 00
ed 18 58 15L£f eel 61 72 [01 b4 30 b7 300307
33 81 bc 30 01 cl 31 B1 5 2 81 cc 30 81 d5 32
1 df 30 Bl ea 3b 81 ea 1c 81 c6 1c B1 25 20 A1
8 22 01 F1 24 81 55 1f @1 48 b @1 3d 29 81 37
1a 81 36 Bs 01 18 06 81 17 @8 Tf £f @1 FF Ff 81
FF FF 01 FF ff B1 09 87 89 19 ff
£ 19 08 11 73 88 16 & Gt
b7 38 01 b7 36 B1 bc 38 @1 cl 3@ OL ¢5 2 81 cc

31 61d5 32 01 of 31 81 ea 3c @1 e9 1c BL 5 1c
1 25 23 B 8a 22 B1 61 24 Bl 54 1F 81 48 20 81
3d 27 B1 37 1e B1 35 Ba B1 18 Bs B1 17 BF FF FF
@1 £F £f BL Ff Ff @1 FF Ff BL £f £f 22 £F Ff 38
FfFF 19 FF £f 19 00 11 72 80 16 aam a8
81 b4 3e B1 b7 31 01 b7 38 €L bc 38 B cL 30 Bl
6 2fF 01 cc 31 81 d5 32 @1 ¢f 31 01 ea 3b 01 e
15 @1 ¢5 1c @1 a4 20 81 8a 22 B1 60 24 ©L 54 20
@1 47 2b B1 3¢ 27 @1 37 1b @1 35 Ba 01 18 06 Bl
17 B8 FF FF 01 FF FF @1 FF FF D1 FF FF B1 FF FF
2= £F FF da FF FF1d FF FF 19 00 11 71 00 16 a8

Data block 1
Channel 1 data calculation
Distarice flag 0w Atten byta 10xde;
Distance byte 10x01b4; getatten On3e;
Get distance 0x01b4; combine the byte :0x3e;
Convert to decimal :62;

Corvert o decimal:435; resuft =h2:
Multiply by :D.5cm;
Result 2.18m;

Data block 2

Azimuth n+2 calculation

Second azimuth :0x6186;
Get azimuth 10x61 &0x86;
Combine the byte  :0x6186;
Convert to decimal :24366;
Divide by :100;

Result :249.66°

Figure 8: Details of MSOP Packet.

5.2 DIFOP

DIFOP is abbreviation of Device Info Output Protocol. I/O type: device output, computer

read.
Default port number is 7788.

DIFOP is a protocol that reports and outputs only device information including the device
serial number, firmware version, driver compatibility, internet setting, calibration data,
electrical machine setting and operation status, fault detection information to users. It is a
viewer for users to get comprehensive details about the device.

Each DIFOP packet is 1248 bytes long, and comprises an 8-byte Header, a 1238-byte

data field, and a 2-byte tail.
The structure of DIFOP is as shown in Table 5.
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Table 5: DIFOP Packet Definition.

Segment No. Information Offset Length/byte
Header 0 DIFOP header 0 8
1 Motor rotation speed (MOT_SPD) 8 2
2 Ethernet (ETH) 10 22
3 FQOV setting 32 4
4 Reserved 36 2
5 Motor phase lock (MOT_PHASE) 38 2
6 Top board firmware version (TOP_FRM) 40 5
7 Bottom board firmware version 45 5
(BOT_FRM)

Reserved 50 242
Data 9 Serial number (SN) 292 6
10 Zero angle offset 298 2
11 Return mode 300 1
12 Upper computer compatibility 301 2

13 UTC time (UTC_TIME) 303 10

14 Operation status (STATUS) 313 18

15 Reserved 331 11

16 Fault diagnosis (FALT_DIGS) 342 40

17 GPRMC 382 86

18 Corrected vertical angle 468 96

19 Corrected horizontal angle 564 96

20 Reserved 660 586

Tail 21 Tail 1246 2

Note: The Header (the DIFOP identifier) in the table above is 0xA5, OxFF, 0x00, 0x5A,
Ox11, Ox11, 0x55, 0x55, among which the first 4 byte 0xA5, OxFF, 0x00, 0x5A is the
sequence to identify the packet.

The tail is 0xOF, OxFO.

For definition of information registers as well as their usage, please check more details in
Appendix B of this manual.

53 UCWP

I/O type: computer writes into the device.

Function: user can reconfigure Ethernet connection, time and some parameters of the
device.

Each UCWP Packet is 1248 bytes long, and is comprised of a 8-byte Header and a
40-byte data field.

The UCWP packet structure is as shown in Table 6 below:

13
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Table 6: UCWP Packet Definition.

Segment No. Information Offset Length/byte
Header 0 UCWP header 0 8
Data 1 Motor rotation speed 8 2
2 Ethernet 10 22
3 FOV setting 32 4
4 Time 36 10
5 Motor phase lock 46 2

Note: The Header (UCWP identifier) in the table above is 0xAA, 0x00, OxFF, 0x11,
0x22, 0x22, OxAA, 0xAA, among which, the first 4 bytes 0xAA, 0x00, OxFF, 0Ox11
forms the sequence to identify the packet.

Statement: RS-Bpearl doesn’t RTC system to support operation while power is off. In the
case of no GPS or GPS signal, it is imperative to write time into the device through a
computer, or it will use a default system time for clock.
Refer to Part 2, Section 10 of this manual for details on Ethernet, Time, Motor Rotation
Speed and Motor Phase Lock.

Table 7: An Example for corresponding value of Setting.

Information Content Setting Length/byte
0xAA,0x00,0xFF,
Header 0x11,0x22,0x22, 8
0xAA,0xAA
0x02
Rotate Speed 600rpm 0x58 2
LiDAR IP 0xCO
(LIIDAR_IP) 192.168.1.105 0xA8 4
0x01
0x69
Destinat 0xCO
(etflt—:lgaTtl_oF?cFi?Pl)P 192.168.1.225 0xA8 4
0x01
OxE1
Device MAC Address 001C23174ACC 0x00,0x1C,0x23, 5
(MAC_ADDR) 0x17,0x4A,0xCC
MSOP Port(port1) 6688 0x1A20 2
MSOP Port(port2) 6688 0x1A20 2
DIFOP Port(port3) 8899 0x22C3 2
DIFOP Port(port4) 8899 0x22C3 2
FOV start angle 0 0x0000 2
FOV end angle 12000 0x2EEOQ 2
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Year:2017 0Ox11
Month:3 0x03
Day:10
Hour:9 0x0A
UTC_TIME Minute:45 0x09 10
Second:30 0x2D
Mllllsecond: 100 Ox1E
Microsecond: 200 0x00,0x64
0x00,0xC8
Motor Phase Lock 90 0x005A 2

While setting the device and computer according to this protocol, it is imperative to set all
the information listed in the table above. Addressing or writing in with part of the
information will lead to invalid setting. The function refreshes the moment the
correspondent parameter is changed, but the network parameters only take effect when
the next initialization of device is started.
RSVIEW provides the configuration Ul, so we suggest to use RSVIEW to configure the
RS-Bpearl. When performing the parameter writing process, please keep the power
connection for LIDAR and make sure the parameter writing is done when we want to
power off the LIDAR, otherwise there is a risk of parameter configuring error.
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6. GPS Synchronization

RS-Bpearl supports external GPS receiver connections. With GPS connections, we can
synchronize the RS-Bpearl system time and pack the GPRMC message into DIFOP
packets.

6.1 GPS Synchronization Theory

The GPS receiver keeps generating synchronization Pulse Per Second (PPS) signal and
GPRMC message and send them to the sensor. The pulse width of the PPS should
between 20 ms to 200 ms, and the GPRMC message should be received within 500 ms
after the PPS signal is generated.

6.2 GPS Usage

There is only one level protocol for RS-Bpearl GPS_REC pins: RS232 level standard

The GPS interface on the Interface BOX is SH1.0-6P female connector, the pin
definition is as shown in Figure 3.

RS232 pin definition:

Pin GPS REC receives the data that is R232 level standard from the GPS module serial
port;

Pin GPS PULSE receives the PPS from GPS module, and the level requirement is
3.0V~15.0V;

If the GPS output you are using is RS232 serial protocol while the level of the LIDAR
receiver is TTL, then you need to purchase a module which converts RS232 level to TTL
level. For one example, the wiring diagram and definition are as follows:

Pin +5V can supply the power for GPS module. (Please do not connect the GPS into the
+5V pin if the GPS is 3.3V power supply. Also please do not input the power into the +5V
pin because the pin is an output.)

Pin GND provide the ground connection for GPS module.

The GPS module should set to 9600bps baud rate, 8-bit data bit, no parity and 1 stop bit.
RS-Bpearl only read the GPRMC message from GPS module., the GPSMRC message
format is shown as below:

$GPRMC,<1>,<2> <3> <4> <5> <6> <7> <8> <9> <10>,<11>,<12>*hh

<1> UTC time

<2> validity - A-ok, V-invalid

<3> Latitude

<4> North/South

<5> Longitude

<6> East/West

<7> Ground Speed

<8> True course<9> UTC date

<10> Variation

<11> East/West

<12> Mode (A/D/E/N=)

*hh checksum from $ to *

Different GPS module may send out different length GPRMC message, the RS-Bpearl
reserve 86byte space for GPRMC message, so it can be compatible with the maijority
GPS module in the market.
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7. Key Characteristic

7.1 Return Mode

7.1.1 Return Mode Principle

RS-Bpearl supports multiple return modes: Strongest return, Last return, and Dual return
modes. When set to dual return mode, the details of the target will be enhanced, and the
number of point is twice than that of a single return.

Due to the divergence of the beam, it is possible to generate multiple laser returns with
one laser emission. When the laser pulse is emitted, its light spot gradually becomes
larger. Suppose a light spot is large enough to shot multiple targets and produce multiple
returns. Generally, the farther away the target is, the weaker it will be at the receiver, while
the high reflective surface may be the opposite.

RS-Bpearl analyzes the received multiple return values and outputs the strongest, last or
simultaneous output of these two return values depending on the setting. If set to the
strongest return mode, only the strongest reflected return value is output. Similarly, if the
setting is the last return mode, only the last return value is output; if set to double return
mode, the strongest and last return information is output simultaneously.

Note: Only when the distance between two objects is greater than 1 meter, the LIDAR
could distinguish these two returns.

7.1.1The Strongest Return

When the LIDAR beam hits only one object, there is only the strongest return at this time.

7.1.2Strongest, Last and Dual Returns

When the laser pulse hit two objects at different distances, there will be two return wave,
then it will lead two situations:

(1) When the strongest return is not the last return, return the strongest and last return;
(2) When the strongest return is also the last return, return the strongest return and the
second strongest return.

7.1.3Return Mode Flag

The factory default setting for RS-Bpearl is the Strongest Return mode. If you need to

change the settings, please refer to Figure C-14 in Appendix C of this user manual. The

300th Byte in the DIFOP is the flag of the return mode, which corresponds to the following:
Table 8: Interchange between Return Mode and Flag Position.

Flag Position Return Mode
00 Dual Returns

01 Strongest Return
02 Last Return
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7.2 Phase Lock

When using multiple RS-Bpearl sensors in proximity to one another, users may observe
interference between them due to one sensor picking up a reflection intended for another.
To minimize this interference, RS-Bpearl provides a phase-locking feature that enables
the user to control where the lase firings overlap.

The Phase Lock feature can be used to synchronize the relative rotational position of
multiple sensors based on the PPS signal and relative orientation. To operate correctly,
the PPS signal must be present and locked. Phase locking works by offsetting the rising
edge of the PPS signal.
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Figuré 9: Different phase lock angles 0°/135°/270°.

The red arrows in Figure 9 above indicate the firing direction of the sensor’s laser the
moment it receives the rising edge of the PPS signal.

In the Tools > RS-LiDAR Information of RSVIEW, we can set the Phase Lock angle from 0
to 359.

Only if the rotate speed is set to 600 rpm / 1200 rpm, the function of phase lock can be
worked.
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8. Point Cloud

8.1 Coordinating Mapping

In data packet including the measured azimuth and distance, in order to calculating the
point cloud, the coordinate in polar coordinate system should be transferred to the 3D
XYZ coordinate in Cartesian Coordinate System, as shown in figure 10. The function of
how to transfer the information is as shown below:

x=rcos(w)sin(a+ 9J);

y=rcos(w)cos(a+9d);

z =rsin(w);

Here r is the reported distance, @ is the vertical angle of the laser (which is fixed and is
given by the Laser ID), and ¢ is the horizontal angle/azimuth reported at the beginning of
every other firing sequence. § is the angle offset of the azimuth. x, y, z values are the
projection of the polar coordinates on the XYZ Cartesian Coordinate System.
The angle.csv file including @ and & can be exported from RSView. Please refer to
Appendix B.13 and B.14.
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Figure 10: Coordinate system mapping between polar system and XYZ system.

Note 1: In the RS-Bpearl ROS package, the coordinate system must be transferred to the
ROS right-hand Coordinate system.
The ROS-X axis is co-axis with the Y-axis and with same direction as Figure 10.

The ROS-Y axis is co-axis with the X-axis but the positive direction is reverse as Figure
10.

The Z axis is same before and after transformation.
Note 2: The origin of the LiDAR coordinate is defined at the center of the LIDAR structure,
with 94.27 mm high to the bottom of the LiDAR.
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9. Definition of Vertical Angles

RS-Bpearl has a vertical field of view of 90° with a non-uniform distribution. The 32 laser
heads also called as 32 channels. The calibrated vertical angle and horizontal angle offset

can be found in DIFOP data.
Table 9: Correspondence between Channel No. and vertical Angle.

Channel Vertical Angle Horizontal Offset Angle
No.
1 89.5 0
2 81.0625 0
3 78.25 0
4 72.625 0
5 67 0
6 61.375 0
7 55.75 0
8 50.125 0
9 86.6875 0
10 83.875 0
11 75.4375 0
12 69.8125 0
13 64.1875 0
14 58.5625 0
15 52.9375 0
16 47.3125 0
17 445 0
18 38.875 0
19 33.25 0
20 27.625 0
21 22 0
22 16.375 0
23 10.75 0
24 5.125 0
25 41.6875 0
26 36.0625 0
27 30.4375 0
28 24.8125 0
29 19.1875 0
30 13.5625 0
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31

7.9375

32

2.3125

Every sequence of 32 laser firings consumes 55.5us.
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10.Reflectivity

The reflectivity is included in the data field of MSOP packet. Reflectivity is a scale to
evaluate the ability of the reflection of light from object. This value is highly related to the
material of measured object. Hence, the character can be used to distinguish the different
materials.

RS-Bpearl reports reflectivity values from 0 to 255 with 255 being the reported reflectivity
for an ideal reflector. Diffuse reflection reports values from 0 to 100, with the weakest
reflectivity reported from black objects and strongest reflectivity reported from white object.
Retro-reflector reports values from 101 to 255.

Diffuse Reflector

Black, diffuse reflector Black, diffuse reflector
Reflectivity == 0 Reflectivity < 100

Retro-Reflector

Retro-Reflector is covered Retro-Reflector without
with semi-transparent any coverage
Reflectivity = 100 Reflectivity = 255

Figure 11: Calibration of Reflectivity.
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11.Troubleshooting

This section provides detail on how to troubleshoot your sensor.

Problem Resolution
Interface BOX red LED doesn’t |® Verify the power connection and polarity
light or blink ® Verify the power supply satisfy the requirement (at least 3A @ 12V)

Interface BOX red LED lights on

but green LED doesn’t light or |® Verify the connection between Interface BOX and LiDAR is solid.
blink
Rotor doesn’t spin ® \Verify the Interface BOX LEDs is okay
P ® Verify the connection between Interface BOX and LiDAR is solid.
® \erify the power connection and polarity
. ® Verify the power supply satisfy the requirement (at least 3A @ 12V)
Reboot at the boot time g 5100k if the LIDAR mounting plane is level or if the LIDAR bottom
fixing screws are too tight.
® \Verify network wiring is functional.
® Verify receiving computer's network settings.
T ® Verify packet output using another application (e.g. Wireshark)
Unit spins but no data ® \Verify no security software is installed which may block Etherne
broadcasts.
® Verify input voltage and current draw are in proper ranges
® Check no firewall is active on receiving computer.
® Check the receiving computer’s IP address is the same as LiDAR

destination IP address.

Check the RSVIEW Data Port setting.
Check the RSVIEW installation path and LiDAR configuration files path
both do not contain any Chinese characters.
Check if the wireshark receive the MSOP packets.

Can see data in Wireshark but
not RSVIEW

This is nearly always an issue with the network and/or user computer.
Check the following:

Is there excessive traffic and/or collisions on network?

Are excessive broadcast packets from another service being
Data dropouts receivedby the sensor? This can slow the sensor down.

Is the computer fast enough to keep up with the packet flow coming
from the sensor?

® Remove all network devices and test with a computer directly connecteq
to the sensor.
® Check baud rate is 9600 and serial port set to 8N1 (8 bits, no parity, 1
stop bit).
® Check the signal level is RS232 level
GPS not synchronizing ® Check electrical continuity of PPS and serial wiring
® Check incorrect construction of NMEA sentence
® Check the GPS and Interface BOX are connected to the same GND
® Check the GPS receive the valid data
No data via router ® Close the DHCP configuration
Sensor point cloud data distortion |® Check the configuration files is right
A blank region rotates in the ® This is the normal phenomenon as the ROS driver use fixed packets
cloud data when using ROS quantity to divide display frame. The blank region data will output in the
driver next frame.

If the computer is windows 10 OS, then run the RSVIEW with windows

Point cloud data to be a radial 7 OS compatible mode.
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Appendix A Point Time Calculate

A.1 RS-Bpearl Calculation of time stamp in single mode

In each MSOP packet, there are 12 blocks, each block has one sequence for the whole 32
laser firings, so in a MSOP packet, there are 12 groups for the whole 32 laser firings. At
every firing moment, there are two laser firing together, all 32 lasers are fired and
recharged every 55.52 us. The cycle time between firing is 1.28 us. 32 firings cost time 32
x 1.28 ps = 40.96 ps. Besides, the charge/recharge time and wait time after emission must
be calculated. Therefore, this time interval = 2 * charge time + 2 * recharge time + wait
time=2*4.00us +2*1.20 us + 4.16 us = 14.56 us.

Table A - 1: Time Offset for each Channel in single Return Mode.

channel Data Block

ID 1 2 3 4 5 6 7 8 9 10 11 12

1 0.00 55.52 | 111.04 | 166.56 | 222.08 | 277.60 | 333.12 | 388.64 | 444.16 | 499.68 | 555.20 | 610.72
2 2.56 58.08 | 113.60 | 169.12 | 224.64 | 280.16 | 335.68 | 391.20 | 446.72 | 502.24 | 557.76 | 613.28
3 5.12 60.64 | 116.16 | 171.68 | 227.20 | 282.72 | 338.24 | 393.76 | 449.28 | 504.80 | 560.32 | 615.84
4 7.68 63.20 | 118.72 | 174.24 | 229.76 | 285.28 | 340.80 | 396.32 | 451.84 | 507.36 | 562.88 | 618.40
5 10.24 | 65.76 | 121.28 | 176.80 | 232.32 | 287.84 | 343.36 | 398.88 | 454.40 | 509.92 | 565.44 | 620.96
6 12.80 | 68.32 | 123.84 | 179.36 | 234.88 | 290.40 | 345.92 | 401.44 | 456.96 | 512.48 | 568.00 | 623.52
7 15.36 | 70.88 | 126.40 | 181.92 | 237.44 | 292.96 | 348.48 | 404.00 | 459.52 | 515.04 [ 570.56 | 626.08
8 17.92 | 73.44 | 128.96 | 184.48 | 240.00 | 295.52 | 351.04 | 406.56 | 462.08 | 517.60 | 573.12 | 628.64
9 25.68 | 81.20 | 136.72 | 192.24 | 247.76 | 303.28 | 358.80 | 414.32 | 469.84 | 525.36 | 580.88 | 636.40
10 28.24 | 83.76 | 139.28 | 194.80 | 250.32 | 305.84 | 361.36 | 416.88 | 472.40 | 527.92 | 583.44 | 638.96
11 30.80 | 86.32 | 141.84 | 197.36 | 252.88 | 30840 | 363.92 | 419.44 | 474.96 | 530.48 | 586.00 | 641.52
12 33.36 | 88.88 | 144.40 | 199.92 | 255.44 | 310.96 | 366.48 | 422.00 | 477.52 | 533.04 | 588.56 | 644.08
13 3592 | 91.44 | 146.96 | 202.48 | 258.00 | 313.52 | 369.04 | 424.56 | 480.08 | 535.60 | 591.12 | 646.64
14 38.48 | 94.00 | 149.52 | 205.04 | 260.56 | 316.08 | 371.60 | 427.12 | 482.64 | 538.16 | 593.68 | 649.20
15 41.04 | 96.56 | 152.08 | 207.60 | 263.12 | 318.64 | 374.16 | 429.68 | 485.20 | 540.72 | 596.24 | 651.76
16 4360 | 99.12 | 154.64 | 210.16 | 265.68 | 321.20 | 376.72 | 432.24 | 487.76 | 543.28 | 598.80 | 654.32
17 1.28 56.80 | 112.32 | 167.84 | 223.36 | 278.88 | 334.40 | 389.92 | 445.44 | 500.96 | 556.48 | 612.00
18 3.84 59.36 | 114.88 | 170.40 | 225.92 | 281.44 | 336.96 | 392.48 | 448.00 | 503.52 [ 559.04 | 614.56
19 6.40 61.92 | 117.44 | 172.96 | 228.48 | 284.00 | 339.52 | 395.04 | 450.56 | 506.08 | 561.60 | 617.12
20 8.96 64.48 | 120.00 | 175.52 | 231.04 | 286.56 | 342.08 | 397.60 | 453.12 | 508.64 | 564.16 | 619.68
21 1152 | 67.04 | 122.56 | 178.08 | 233.60 | 289.12 | 344.64 | 400.16 | 455.68 | 511.20 | 566.72 | 622.24
22 14.08 | 69.60 | 125.12 | 180.64 | 236.16 | 291.68 | 347.20 | 402.72 | 458.24 | 513.76 | 569.28 | 624.80
23 16.64 72.16 127.68 | 183.20 | 238.72 | 294.24 | 349.76 | 405.28 | 460.80 | 516.32 | 571.84 | 627.36
24 19.20 | 74.72 | 130.24 | 185.76 | 241.28 | 296.80 | 352.32 | 407.84 | 463.36 | 518.88 | 574.40 | 629.92
25 26.96 | 82.48 | 138.00 | 193.52 | 249.04 | 304.56 | 360.08 | 415.60 | 471.12 | 526.64 | 582.16 | 637.68
26 29.52 | 85.04 | 140.56 | 196.08 | 251.60 | 307.12 | 362.64 | 418.16 | 473.68 | 529.20 | 584.72 | 640.24
27 32.08 | 87.60 | 143.12 | 198.64 | 254.16 | 309.68 | 365.20 | 420.72 | 476.24 | 531.76 | 587.28 | 642.80
28 34.64 | 90.16 | 145.68 | 201.20 | 256.72 | 312.24 | 367.76 | 423.28 | 478.80 | 534.32 | 589.84 | 645.36
29 37.20 | 92.72 | 148.24 | 203.76 | 259.28 | 314.80 | 370.32 | 425.84 | 481.36 | 536.88 | 592.40 | 647.92
30 39.76 | 95.28 | 150.80 | 206.32 | 261.84 | 317.36 | 372.88 | 428.40 | 483.92 | 539.44 | 594.96 | 650.48
31 4232 | 97.84 | 153.36 | 208.88 | 264.40 | 319.92 | 375.44 | 430.96 | 486.48 | 542.00 | 597.52 | 653.04
32 4488 | 100.40 | 155.92 | 211.44 | 266.96 | 322.48 | 378.00 | 433.52 | 489.04 | 544.56 | 600.08 | 655.60

In the firing sequence, Bpearl is first charged once, then the lasers fire one by one from
channel 1 to channel 8 and from channel 17 to channel 24 respectively. After that, Laser
emitters are charged once again, then lasers fire from Channel 9 to channel 16 and from
channel 25 to channel32 respectively.

Set the channel number data_index is 1~32, sequence_index is 1~12. Because the time
stamp is the time of the first data point in the packet, you need to calculate a time offset for
each data point and then add this offset to the time stamp.
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Time_offset is:

Formal for Calculation of Time_offset from Channel 1 to channel 8 and from channel 17 to
channel 24:

Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index — 1) , 16) + 1.28 *
floor((data_index-1) / 16)

Formal for Calculation of Time_offset from Channel 9 to channel 16 and from channel 25
to channel 32:

Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index — 1) , 16) + 1.28 *
floor((data_index-1) / 16) + 5.2

To calculate the exact point time, add the Time_Offset to the timestamp:
Exact_point _time = Timestamp + Time_offset
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A.2 RS-Bpearl Calculation of time stamp in dual mode

In dual mode, for each MSOP packet, there are 12 blocks. Each two block has one
sequence for the whole 32 laser firings, e.g. Block 1 and Block 2 are two captured return
signals after all 32 laser emitting once, Block 1 is the strongest return signal, block 2 is the
second strongest return signal.

Set the channel number data_index is 1~32, sequence_index is 1~12. Because the time
stamp is the time of the first data point in the packet, you need to calculate a time offset for
each data point and then add this offset to the time stamp.

Table A - 2. Time Offset for Each Channel in dual return mode.

channel Data Block
ID
1 2 3 4 5 6 7 8 9 10 11 12

1 0.00 0.00 | 55.52 55.52 | 111.04 | 111.04 | 166.56 | 166.56 | 222.08 | 222.08 | 277.60 | 277.60
2 2.56 2.56 | 58.08 58.08 | 113.60 | 113.60 | 169.12 | 169.12 | 224.64 | 224.64 | 280.16 | 280.16
3 5.12 5.12 | 60.64 60.64 | 116.16 | 116.16 | 171.68 | 171.68 | 227.20 | 227.20 | 282.72 | 282.72
4 7.68 7.68 | 63.20 63.20 | 118.72 | 118.72 | 174.24 | 174.24 | 229.76 | 229.76 | 285.28 | 285.28
5 10.24 | 10.24 | 65.76 65.76 | 121.28 | 121.28 | 176.80 | 176.80 | 232.32 | 23232 | 287.84 | 287.84
6 12.80 | 12.80 | 68.32 68.32 | 123.84 | 123.84 | 179.36 | 179.36 | 234.88 | 234.88 | 290.40 | 290.40
7 15.36 | 1536 | 70.88 70.88 | 126.40 | 126.40 | 181.92 | 181.92 | 237.44 | 237.44 | 292.96 | 292.96
8 17.92 | 1792 | 73.44 7344 | 128.96 | 128.96 | 184.48 | 184.48 | 240.00 | 240.00 | 295.52 | 295.52
9 25.68 | 25.68 | 81.20 81.20 | 136.72 | 136.72 | 192.24 | 192.24 | 247.76 | 247.76 | 303.28 | 303.28
10 28.24 | 28.24 | 83.76 83.76 | 139.28 | 139.28 | 194.80 | 194.80 | 250.32 | 250.32 | 305.84 | 305.84
11 30.80 | 30.80 | 86.32 86.32 | 141.84 | 141.84 | 197.36 | 197.36 | 252.88 | 252.88 | 308.40 | 308.40
12 33.36 | 33.36 | 88.88 88.88 | 144.40 | 144.40 | 199.92 | 199.92 | 255.44 | 255.44 | 310.96 | 310.96
13 3592 | 3592 | 91.44 9144 | 146.96 | 146.96 | 202.48 | 202.48 | 258.00 | 258.00 | 313.52 | 313.52
14 38.48 | 38.48 [ 94.00 94.00 | 149.52 | 149.52 | 205.04 | 205.04 | 260.56 | 260.56 | 316.08 | 316.08
15 41.04 | 41.04 | 96.56 96.56 | 152.08 | 152.08 | 207.60 | 207.60 | 263.12 | 263.12 | 318.64 | 318.64
16 43.60 | 43.60 [ 99.12 99.12 | 154.64 | 154.64 | 210.16 | 210.16 | 265.68 | 265.68 | 321.20 | 321.20
17 1.28 1.28 | 56.80 56.80 | 112.32 | 112.32 | 167.84 | 167.84 | 223.36 | 223.36 | 278.88 | 278.88
18 3.84 3.84 | 59.36 59.36 | 114.88 | 114.88 | 170.40 | 170.40 | 225.92 | 22592 | 281.44 | 281.44
19 6.40 6.40 | 6192 6192 | 117.44 | 117.44 | 172.96 | 172.96 | 228.48 | 22848 | 284.00 | 284.00
20 8.96 8.96 | 64.48 64.48 | 120.00 | 120.00 | 175.52 | 175.52 | 231.04 | 231.04 | 286.56 | 286.56
21 11.52 | 11.52 | 67.04 67.04 | 122.56 | 122.56 | 178.08 | 178.08 | 233.60 | 233.60 | 289.12 | 289.12
22 14.08 | 14.08 | 69.60 69.60 | 125.12 | 125.12 | 180.64 | 180.64 | 236.16 | 236.16 | 291.68 | 291.68
23 16.64 | 16.64 | 72.16 7216 | 127.68 | 127.68 | 183.20 | 183.20 | 238.72 | 23872 | 294.24 | 294.24
24 19.20 | 19.20 | 74.72 7472 | 130.24 | 130.24 | 185.76 | 185.76 | 241.28 | 241.28 | 296.80 | 296.80
25 26.96 | 26.96 | 82.48 82.48 | 138.00 | 138.00 | 193.52 | 193.52 | 249.04 | 249.04 | 304.56 | 304.56
26 29.52 | 29.52 | 85.04 85.04 | 140.56 | 140.56 | 196.08 | 196.08 | 251.60 | 251.60 | 307.12 | 307.12
27 32.08 | 32.08 | 87.60 87.60 | 143.12 | 143.12 | 198.64 | 198.64 | 254.16 | 254.16 | 309.68 | 309.68
28 34.64 | 3464 | 90.16 90.16 | 145.68 | 145.68 | 201.20 | 201.20 | 256.72 | 256.72 | 312.24 | 312.24
29 37.20 | 37.20 | 92.72 92.72 | 148.24 | 148.24 | 203.76 | 203.76 | 259.28 | 259.28 | 314.80 | 314.80
30 39.76 | 39.76 | 95.28 95.28 | 150.80 | 150.80 | 206.32 | 206.32 | 261.84 | 261.84 | 317.36 | 317.36
31 4232 | 4232 | 97.84 97.84 | 153.36 | 153.36 | 208.88 | 208.88 | 264.40 | 264.40 | 319.92 | 319.92
32 4488 | 44.88 | 100.40 | 10040 | 15592 | 155.92 | 21144 | 211.44 | 266.96 | 266.96 | 322.48 | 322.48
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Time_offset is:

Formal for Calculation of Time offset from Channel 1 to channel 8 and
from channel 17 to channel 24:

Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 256 *
mod((data_index — 1) , 16)

+ 1.28 * floor((data_index-1) / 16)

Formal for Calculation of Time_offset from Channel 9 to channel 16 and
from channel 25 to channel 32:

Time_offset = 5552 * (floor ((sequence index - 1) /2)) + 256 *
mod((data_index — 1) , 16)

+ 1.28 * floor((data_index-1) / 16) + 5.2

To calculate the exact point time (Exact_point _time), add the Time_Offset
to the timestamp:
Exact_point _time = Timestamp + Time_offset

Note:
mod is an operator that divides two numbers and returns only the remainder.
floor is a function that returns an integer less than the argument or equal to it.
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Appendix B Information Registers

Here are definitions and more details on information registers as mentioned in chapter 5.

B.1 Motor(MOT_SPD)

Motor Speed (2 bytes in total)

Byte No. byte1 | byte2

Function MOTOR_SPD

Register description:
(1) This register is used to set the rotation direction and rotation speed.
(2) The data storage format adopts big endian format.

(3) Supported rotation speed:
(byte1==0x04) && (byte2==0xB0) speed 1200rpm, clockwise rotation;
(byte1==0x02) && (byte2==0x58) speed 600rpm, clockwise rotation;
(byte1==0x01) &&(byte2==0x2C) speed 300rpm, clockwise rotation;
If set the value of rotation with other data, the rotation speed of the motor is 0.

B.2 Ethernet(ETH)

Ethernet (26 bytes in total)

ByteNo. [ bytel | byte2 | byte3 | byted byte5 | byte6 byte7 | byte8
Function LIDAR_IP DEST_PC_IP

Byte No. byte9 | byte10 | byte11 [ byte12 byte13 | byte14 byte15 | byte16
Function MAC_ADDR port1

Byte No. [ byte17 | byte18 byte19 | byte20 byte21 | byte22 |
Function port2 port3 port4

Register description:
(1) LIDAR_IP is the LIDAR source IP address, it takes 4 bytes.
(2) DEST_PC_IP is the destination PC IP address, it takes 4 bytes.
(3) MAC_ADDR is the LIiDAR MAC Address.

(4) port1~port6 signals the number of ports. Port1 and port2 are the
MSOP packet ports, we suggested to set them to the same number.
Port3 and port4 are the DIFOP packet ports, we suggested to set
them to the same number.
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B.3 FOV Setting (FOV SET)

FOV Setting(Total 4bytes)
Byte No. byte1 | byte2 byte3 | byted
Function FOV_START FOV_END

Register Description:

Set the horizontal angle range of the device for outputting valid data, FOV_START and
FOV_END adjustment range 0~36000, corresponding angle 0~360°, the data storage
format adopts big endian format.

For example:

byte1=0x5d, byte2=0xc0, byte3=0x1f, byte4=0x40,

so:

FOV_START = 93*256+192=24000 FOV_END = 31*256+64=8000

Indicates that the valid data output has a horizontal angle ranging from 240.00°to 80.00°.
Note: In all above calculation, bytes have been transformed to decimal.

B.4 Motor Phase Offset (MOT_PHASE)

Motor Phase Offset(2bytes in total)
Byte No. byte1 | byte2
Function MOT_PHASE

Register description: It can be used to adjust the phase offset of the motor with the PPS
together. The value can be set from 0 to 360. The data storage format adopts big endian
format.
For example:

the byte1=1, byte2=14, so the motor phase should be 1*256+14 = 270.
Note: In all above calculation, bytes have been transformed to decimal.

B.5 Top Board Firmware (TOP_FRM)

Top Board Firmware(5bytes in total)

ByteNo. | bytel | byt2 | Byte3 | Byte4 | Byte5

Function TOP_FRM

Register description:

If our top board firmware revision is T6R23V6_T6_ A, then TOP_FRM will output 06 23 06
06 A0,0x06230606A0.

In the output, the A represents release version Application, while the F represents factory
version Factory.
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B.6 Bottom Board Firmware (BOT_FRM)

Bottom Board Firmware(5bytes in total)
Byte No. byte1 | byte2 | Byte3 | Byte4 | Byte5
Function BOT_FRM

Register description:

If our top board firmware revision is B7TR14V4_T1_F, then BOT_FRM will output 06 23 06
06 FO. In the output, the A represent release version Application, while the F represent
factory version Factory.

B.7 Serial Number(SN)

Serial Number(6 bytes in total)

Byte No. byt | byt2 | byte3 | byted | byte5 | byte6

Function SN

The Serial Number of each device adopts the same format as the MAC_Address, namely,
a 6-byte hexadecimal number.

B.8 Software Version(SOFTWARE_VER)

Software Version(2 bytes in total)

Byte No. byte1 | byte2

Function SOFTWARE_VER

B.9 UTC Time(UTC_TIME)

UTC Time (8 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8
Function year | month day hour min sec ms
Byte No. byte9 | byte10
Function us
Register description:
(1) year

set_year
ByteNo. | bit7 | bit6 | bits | bira bit3 | bit2 | bitt | bit
Function set_year[7:0]: data 0~255 corresponds year 2000 to year 2255.
(2) month

set_month
ByteNo. | bit7 | bit6 bit5 bit4 bitd3 | bi2 | bitt | bito
Function | reserve | reserve | reserve | reserve set_month[3:0]: 1~12 month
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(3) day

set_day
Byte No. |  bit7 bit6 bit | bitd | bit3 | bit2 | bit1 | bit
Function | reserve | reserve | reserve set_day[4:0]: 1~31 day
(4) hour

set_hour
Byte No. |  bit7 bit6 bit | bitd | bit3 | bit2 | bit1 | bit
Function | reserve | reserve | reserve set_hour[4:0]: 0~23 hour
(5) min

set_min
Byte No. |  bit7 bitt | bitb | bit4 | bitd | bit2 | bitt | bt
Function | reserve | reserve set_min[5:0]: 0~59 min
(6) sec

set_sec
ByteNo. | bit7 | bit6 bits | bita | bit3 | bi2 | bitt | bito
Function | reserve | reserve set_sec[5:0]: 0~59 sec
(7) ms

set_ms
Byte No. bit15 bit14 bit13 bit12 bit11 bit10 bit9 | bit8
Function | reserve | reserve | reserve | reserve reserve | reserve ms[9:8]
Byte No. bit7 bité bit5 bit4 bit3 bit2 bit1 | bit0
Function set_ms[7:0]

Note: set_ms[9:0] value: 0~999
®8) us
reg name: set_us
Byte No. | bit15 bit14 bit13 bit12 bit11 bit10 bit9 | bit8
Function | reserve | reserve | reserve | reserve | reserve | reserve us[9:8]
Byte No. bit7 bité bit5 bit4 bit3 bit2 bit1 | bit0
Function set_us[7:0]
Note: set_us[9:0] value: 0~999
B.10 STATUS
Status (18bytes in total)

Byte No. byte1 | byte2 | byte3 byte4 byte5 | byte6 byte7 | byte8
Function Idat1_reg Idat2_reg Vdat_12V_reg
Byte No. | byte9 |byte10 | byte11 | byte12 | byte13 | byte14 | byte15 | byte16
Function | Vdat_12V_M reg Vdat_ 5V _reg Vdat_3V3_reg Vdat_2V5 reg
Byte No. | 17byte | 18byte | | |
Function | Vdat_1V2_reg

Register description:

(1) ldat1 is sensor power supply current, Idat2 is top board power supply current.
We use Idat to represent Idat1 or Idat2. Idat_reg contains 3 bytes to be
Idat_reg[23:0]. Idat_reg[23] is symbol flag, while |dat_reg[22:0] is current value.
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The LSB for Idat is 1yA, the formula is as below:
Idat reg[22:0]----+++- (Idat_reg[23] = 0) Idat reg[22:0]--«-- (Idat_reg[23] = 0)
—Ildat_reg[22:0]---- (Idat_reg[23] =1) —Ildat_reg[22:0]--+-- (Idat_reg[23] = 1)

For example, if byte1 = 8C, byte2 = D5 and byte3 = 00, then the current value is:

ldat = -Idat_reg[22:0] = -0xOCDS500 uA = -840960uA=-841mA

(2) There are six different voltages, each voltage register has 2 bytes to be
Vdat_reg[15:0]. Vdat_reg[15:12] is invalid, while Vdat[11:0] represent the
voltage value. The six different voltage formula is as below:

Vdat 12V =Vdat 12Vreg[11:0]/40% + 2.5+12
Vdat 12V M = Vdat 12V.M reg[11:0]/409 + 2.5+ 12

Idat= { Idat= {

Vdat 5V = Vdat5V reg[11:0]/40% = 2.5+ 4
Vdat 3V3=Vdat3V3reg[11:0]/40%« 2.5+2
Vdat 2V5 = Vdat 2V5reg[11:0]/40% » 2.5+ 2
Vdat 1V2=Vdat 1V2reg[11:0]/40% = 2.5+ 2

The unit above is volt (V).

B.11 Fault Diagnosis

Fault Diagnosis (40bytes in total)

ByteNo. | bytel | byte2 | byte3 | byted | byte5 | byte6 | byte7 | byte8
Function internal debug

Byte No. | byte9 | byte10 | bytel1l | byte12 | byte13 byte14 | bytel5 byte16
Function internal debug cksum_st manc_err1 manc_err2 gps_st
Byte No. byte17 | byte18 byte19 byte20 byte21 byte22 byte23 byte24
Function temperature1 temperature2 temperature3 temperature4
Byte No. | byte25 | byte26 | byte27 | byte28 byte29 | byte30 byte31 byte32
Function temperature5 internal debug r_rpm1
Byte No. | byte33 byte34 | byte35 | byte36 | byte37 | byte38 | byte39 byte40
Function r_rpm2 internal debug

Register description:
(1) chksum_st represents the temperature compensation status. If chksum_st = 0x00, the
temperature compensation is working. If chksum_st = 0x01, the temperature
compensation is, the temperature compensation is abnormal.
(2) manc_err1 and manc_err2 are used to calculate the bit error rate of the data
communication. manc_err1 represents 1bit error, while manc_err2 represents 2bit error.
The error rate formula is as below:
manc_errl_per = manc_err1/65536 * 100%
manc_err2_per = manc_err2/65536 * 100%
When the manc_errl_per and manc_errl_per are both zero, the system data
communication is normal.
(3) Temperature1 and temperature2 represent the bottom board temperature, while
temperature3 and temperature4 represent the top board temperature. Each temperature
register contains 2 bytes to be temperature_reg[15:0]. temperature_reg[2:0] is invalid.
temperature_reg[15:3] is temperature value, while temperature_reg[15] is symbol flag.
The temperature formula is as below:
temperature[15:3] /16 (temperature[15] =0)

LenprLire Ll { —( (8192 —temperature[15:3])/16) (temperature[15] = 1)
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Temperature5 represents bottom board temperature. The temperature register contains 2

bytes

to be

temperature_reg[15:0].

temperature_reg[15:12] is

invalid.

temperature_reg[11:0] is temperature value, while temperature_reg[15] is symbol flag.

temperatureb= {

temperature[11: 0] /4
— (4096 — temperature[11:0])/4

(temperature[1l] =0)
(temperature[11l] = 1)

(4) Byte16 represents the GPS input status register gps_st, this register uses 3 bits to
describe the validation for PPS, GPRMC, and timestamp. The details are shown below:

GPS input status register GPS_ST
BIT Function Value Status
bit0 PPS_LOCK 0 PPS is invalid
1 PPS is valid
) GPRMC flag: 0 GPRMC is invalid
bit1 GPRMC_LOCK 1 GPRMC is valid
0 LiDAR internal timestamp is not synchronizing the
bit2 UTC_LOCK - - : uTC. - —
1 LiDAR internal timestamp is synchronizing the
UTC.
bit3~bit7 Reserved X N/A

(1) The real-time rotation speed of the motor is composed of two bytes, byte32 and
byte33. The calculation formula is as follows:
Motor real-time rotation speed = (256 * r_rpm1 + r_rpm2)+6
(2) The reset is used for internal debug, they are not opened.

B.12 ASCIl code in GPRMC Packet

GPRMC register reserve 86 bytes, it can store the whole GPRMC message from GPS

module in to the register in ASCII code.

B.13 Corrected Vertical Angle (COR_VERT_ANG)

Corrected Vertical Angle (96bytes in total)
ByteNo. | bytel | byte2 | byte3 byte4 | byte5 |  byte6 byte7 | byte8 |  byte9
Function | Channel1 COR VERT ANG Channel 2 COR VERT ANG Channel 3 COR VERT ANG
Byte No. | byte10 | byte11 | byte12 byte13 | byte14 | byte15 byte16 | byte17 |  byte18
Function | Channel 4 COR VERT ANG | Channel5 COR VERT ANG Channel 6 COR_VERT_ANG
Byte No. | byte19 | byte20 | byte21 byte22 | byte23 | byte24 byte25 | byte26 |  byte27
Function | Channel 7 COR VERT ANG Channel 8 COR VERT ANG Channel 9 COR VERT ANG
Byte No. | byte28 | byte29 | byte30 byte31 | byte32 | byte33 byte34 | byte35 |  byte36
Function | Channel 10 COR_VERT ANG | Channel 11 COR_VERT ANG | Channel 12 COR_VERT ANG
Byte No. | byte37 | byte38 | byte39 byte40 | byte41 | byte42 byte43 | byte44 |  byte45
Function | Channel 13 COR VERT ANG | Channel 14 COR VERT ANG Channel 15 COR VERT ANG
Byte No. | byte46 | byte4d7 | byte4s byte49 | byte50 | byte51 byte52 | byte53 |  byte54
Function | Channel 16 COR VERT ANG | Channel 17 COR VERT ANG Channel 18 COR VERT ANG
Byte No. | byte55 | byte56 | byte57 byte58 | byte59 |  byte60 byte61 | byte62 |  byte63
Function | Channel 19 COR VERT ANG | Channel 20 COR_VERT ANG | Channel 21 _COR_VERT ANG
Byte No. | byte64 | byte65 | byte66 byte67 | byte68 |  byte69 byte70 | byte71 |  byte72
Function | Channel 22 COR VERT ANG | Channel 23 COR VERT ANG Channel 24 COR VERT ANG
Byte No. | byte73 | byte74 | byte75 byte76 | byte77 | byte78 byte79 | byte80 |  byte81
Function | Channel 25 COR_VERT ANG | Channel 26 COR_VERT ANG | Channel 27 COR_VERT ANG
Byte No. | byte82 | byte83 | byte84 byte85 | byte86 | byte87 byte88 | byte89 |  byte90
Function | Channel 28 COR VERT ANG | Channel 29 COR VERT ANG Channel 30 COR VERT ANG
Byte No. | byte91 | byte92 | byte93 byte94 | byte95 | byte96
Function | Channel 31_COR_VERT ANG | Channel 32 COR_VERT ANG

33




rcbosense

RS-Bpearl User Manual

Register description:

(1) The angle value is signed integer, vertical angle for each channel is consist of 3
bytes, while the first byte represents the sign, the second byte and the third byte

represent the value for the angle, storage mode is Big-endian.

(2) The first byte 0x00 represents positive while 0x01 represents negative.

(3) LSB=0.01°.

For example the register for vertical angle of Channel 1is as below: byte1=0x00,
byte2=0x22 convert to decimal is 34, byte3=0XF6 convert to decimal is 246, so the
vertical angle of Channel 1 is:

(34*256+ 246) *0.01° = 89.50°

B.14 Corrected Horizontal Offset Angle (COR_HOR_ANG)

Corrected horizontal Angle (96bytes in total)

ByteNo. | bytel | byte2 | byte3 byte4 | byte5 | byte6 byte7 | byte8 | byte9
Function Channel 1 COR HOR ANG Channel 2 COR HOR ANG Channel 3 COR HOR ANG
Byte No. | byte10 | byte11 | byte12 byte13 | byte14 | byte15 byte16 | byte17 | byte18
Function Channel 4 COR HOR ANG Channel 5 COR_ HOR ANG Channel 6 COR_ HOR ANG
Byte No. | byte19 | byte20 | byte21 byte22 | byte23 | byte24 byte25 | byte26 | byte27
Function Channel 7 COR HOR ANG Channel 8 COR HOR ANG Channel 9 COR HOR ANG
Byte No. | byte28 | byte29 | byte30 byte31 | byte32 | byte33 byte34 | byte35 | byte36
Function | Channel 10 COR HOR ANG Channel 11 COR HOR ANG Channel 12 COR HOR ANG
Byte No. | byte37 | byte38 | byte39 byte40 | byted1 | byted2 byte43 | byted4 | byted5
Function | Channel 13 COR_HOR_ANG Channel 14 COR_HOR_ANG Channel 15 COR_HOR_ANG
Byte No. | byte46 | byted7 | byte48 byte49 | byte50 | byte51 byte52 | byte53 | byte54
Function | Channel 16 COR HOR ANG Channel 17 COR HOR ANG Channel 18 COR HOR ANG
Byte No. | byte55 | byte56 | byte57 byte58 | byte59 | byte60 byte61 | byte62 | byte63
Function | Channel 19 COR_HOR_ANG Channel 20 COR_HOR_ANG Channel 21 COR_HOR_ANG
Byte No. | byte64 | byte65 | byte66 byte67 | byte68 | byte69 byte70 | byte71 | byte72
Function | Channel 22 COR HOR ANG Channel 23 COR HOR ANG Channel 24 COR HOR ANG
Byte No. | byte73 | byte74 | byte75 byte76 | byte77 | byte78 byte79 | byte80 | byte81
Function | Channel 25 COR HOR_ANG Channel 26 COR_HOR_ANG Channel 27 COR_HOR_ANG
Byte No. | byte82 | byte83 | byte84 byte85 | byte86 | byte87 byte88 | byte89 | byte90
Function | Channel 28 COR_HOR_ANG Channel 29 COR_HOR_ANG Channel 30 COR_HOR_ANG
Byte No. | byte91 | byte92 | byte93 byte94 | byte95 | byte96

Function | Channel 31 COR HOR ANG Channel 32 COR HOR ANG

Register description :

(1) The angle value is signed integer, vertical angle for each channel is consist of 3
bytes, while the first byte represents the sign, the second byte and the third byte

represent the value for the angle.

(2) The first byte 0x00 represents positive while 0x01 represents negative.

(3) LSB=0.01°;

For example the register for vertical angle of Channel 10 is as below: byte1=0x01,
byte2=0x00 convert to decimal is 0, byte3=0x0A convert to decimal is 10, so the

vertical angle of Channel 10 is:

-(0*256+ 10) *0.01=-0.1°

34



rcbosense RS-Bpearl User Manual

Appendix C RSView

In this appendix, the record, visualization, save and redisplay of the data from RS-Bpearl
will be interpreted with using RSView. The original sensor data can be also captured and
examined by using other free tools, such as Wireshark or TCP-Dump. But visualization of
the 3D data through using RSView is easy to realize. RS-Bpearl is used with RSView
vision 3.1.5. or above

C.1 Software Features

RSView can provide real-time visualization of 3D coordinate data from RS-Bpearl.
RSView can also review the pre-recorded data stored in “pcap” (Packet Capture) files, but
RSView still doesn’t support directly importing “.pcapng” files.

RSView displays directly the point cloud that is exchanged from the measured distance
from RS-Bpearl. It supports changing the display mode of point cloud as user wishes,
according to Reflectivity, timestamp, distance, azimuth, and laser channel. The data can
be exported as XYZ coordinate data in CSV format or LAS format. RSView does not
support generating point cloud files in XYZ, or PLY formats.

Function and features of RSView are shown as follow:

Online visualization of sensor data over Ethernet

Record of real-time data into pcap files

Review of the collected point cloud from pcap files

Different visualization mode based on distance, timestamp, azimuth, laser ID,
etc.

Tabular inspection of point cloud data

Exporting the point cloud data into CSV format

Tool for measuring distance from visualized cloud point

Simultaneously Display of multiple continuous frames (Trailing frames)

Display or hide subsets of lasers

Crop tool to show partial point cloud

C.2 Installation of RSView

Installation packet of RSView is suited for Windows 64-bit system and it has no need for
other dependent software packets.

The latest version of executable installation packet can be found from RoboSense website
(http://www.robosense.ai/resource). Launch the installation packet and follow the
instructions to complete the installation. The installation path should not contain any
Chinese characters.

C.3 Network Setup

As mentioned in the chapter 5, the default IP address of the computer should be set as
192.168.1.102, sub-net mask should be 255.255.255.0. You should make sure RSView
doesn’t be blocked by firewall in PC.

C.4 Visualization of point cloud

1. Connect the RS-Bpearl to PC over Ethernet cables and power supply.
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2. Right Click to start the RSView application with Run as administrator.
3. Click on the “File”-> Open -> Sensor Stream (Fig. C-1).

( @ RsView

) w3y
Open Capture File
Becent Files % Sensor Stream
Save As 3

Choose Calibration File

. Ezport To KEiwiViewer
Save Screenshot

Close Data Ctrltd

Exzit

Figure C - 1: Open sensor stream in RSView.
4. After finishing above 3 steps, the dialogue box “Sensor Configuration” shows up. In this
dialogue box, the default configuration folder of RS-Bpearl calibration is already contained and
the folder is already chosen. In “Type of LIDAR”, the option RSBpearl should be chosen, in
“Intensity”, Mode3 should be chosen. Finally, click “OK” (as shown in Fig. C-2).

| Sensor Configuratior

Sensor Calibration

|ESlidarlf
Eslidar3?

ESEpearl
| on1gurat1 on

1ith
161182100257

Sensor Fosition Type of Lidar Intensity

5| Fitch .00 =) ES1B

4 Rell .00 ) Esa32 ) ModeZ

[ & ][ canca |

Figure C - 2: RSView Select Sensor Correction File.
RSView begins displaying the colored point cloud from capturing the sensor data stream from

LiDAR (as shown in Fig. C-3). The stream can be paused by pressing the “Play/Pause”
button.

Figure C - 3: RSView Sensor Stream Display.
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C.5 Save Streaming Sensor Data into PCAP File

1. Click the “Record” button while real-time display (Fig. C-4).

Kk K > O DM G O

Figure C - 4: RSView Record Button.
2. In the dialogue box Choose Output File, the save path and file name of pcap file can
be set up. (Fig. C-5). After clicking “save” button, RSView begins writing data into pcap file.
(Note: RS-Bpearl will generate enormous measuring data. So, it is best to use a fast, local
HDD or SSD, not to use a slow subsystem such as USB storage device or network drive.)

- A

i

@ Choose Qutput File RS
@"H./V!“;“ r ERL » win7 (T » - |-&? || e winZ [Ty P |
|av  FEuEs = @
B mn i ’ il A [

= R PerfLogs
= I Program Files
ol BEFE ) Program Files (xB6)
4 =% Python27
5 Gt =
1 tenip
&, win (c3) TlsdTemp
window =

(ca FHBEEE (E)

TOHE(N): 2017-07-20-11-43-07-RS-16-Data prap g

ERFEE(T): | peap [7.peap) v

= lEEno=

Figure C - 5: RSView Record Saving Dialog.
3. Click “Record” Button will finish record and save the all recorded data into this pcap
file.

C.6 Replay Recorded Sensor Data from PCAP Files

In order to replaying (or examining) a pcap file, please import it into RSView. Then press
“Play/Pause” button to let it play or scrub the time slider to a certain time point as user
wishes. When only a part of 3D point cloud is concerned, it can be selected out by
mouse. Then point cloud data of this part can be shown in table. Save path of pcap file
can’t contain Chinese characters.

1. Click File -> Open then select Capture File.

@ RsView
_Elie Toels Help
0 = i ]
Upen Capture File
Recent Files % Sensor Strcam
Save As

* Choose Calibration File

o Ezport To KiwiViewer

Save Screenshot

Close Data

Exit

Figure C - 6: RSView Open Capture File.
2. In dialogue box “Open File”, please import a recorded pcap file then click “open (O)”
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[==] Pictures
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B 2D Objects
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&- Downloads
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[&=] Pictures

B videes

W

File name: | back_lidar v| Supported Files (“.inp b “or v

Figure C - 7: Select the PCAP File.

3. In dialogue box Sensor Configuration, please add and select the right configuration
file of RS-Bpearl, then click OK.

4. Clicking “Play/Pause” button can make 3D point cloud stream play and pause. Using
the Scrub tool can select out the interesting frame. (Fig. C-8)

Figure C - 8: RSView Play Button and Scrub slide tool.

5. In order to inspecting partial relevant point cloud data from a closer aspect, please
scrub to an interesting frame and click the Spreadsheet button (Fig. C-9). A data table will
be displayed on the right side. It contains all displayed data points in the frame.

. '@ REView I

File Tools Help

Figure C - 9: RSView Spreadsheet tool.

6. The dimension and the sort of data in this table are adjustable. That can make the
display more obvious. (Fig. C -10)
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Figure C - 10: RSView Data Point Table.
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7. Click “Show only selected elements” in spreadsheet can acquire correspondingdata,
certainly there is no data shown in table, if no one point is selected. (Fig.C -11

EERFEED

Point ID Foints adjustedtime azimuth distance_m intensi.[_ Show only selected elements. -kstamp
a T34 LiTTe 935301570, 000 993 10 380 5 i1 9IGI015T0
1 752 1,814 995301620, 000 1011 10. 415 B 11 9I5301620

Figure C - 11: RSView Show Only Selected Elements.

8. By using “Select All Points” Tool, the arbitrary point can be selected. (as shown in Fig.
C-12)

& svie I «

(e

File Tools Help

;Select M1 Foint=

Figure C - 12: RSView Select All Points.
In the 3D rendered data pane using mouse to draw a rectangle around a small number of
points. The values of them can be immediately shown in the table (Fig. C-13).

PR e e o D —.
Shewing [T Attt TR recision [JENE 13 # 0 00

& 28

Figure C - 13: RSView Selected Points.
9. Any selected point can be saved by doing File->Save As->Select Frames.

C.7 RS-Bpearl Factory Firmware Parameters Setting

RSView supplies a tool which integrates UCWP Protocol. It can be used to modify Rotate
Speed, Network, Time, FOV and return mode in RS-Bpearl factory firmware.

Before setting the firmware parameters, please ensure the connectivity of the RS-Bpearl
and Display of real-time point cloud. Then Click Tools > RS-LiDAR Information, next, in
RS-LiDAR Information dialogue, click “Get” button, the current firmware parameters
setting will be shown in this dialogue.
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MSOP Port:

Mac: oo

Serial Number:
Return Mode: [strongest =

FOV(Deg):

Phase Lock:

Bot. FW. Version:
Top FW. Version:
Year: 17

Hour: 1

DIFOP Port:
la
161190504577
Azimuth Calibration(Deg):
to 360,00
Rotation Speed: £00
03
0a
1

53

l

Get

| [set LDAR

Figure C — 14: RS-LiDAR Information.

After modifying the values of parameters, click “Set LiDAR”, the Parameter will be set to
what user needs (the red marks in Figure C-15 are only an example, it shows a possibility

for parameter change). Then wait 10 seconds, restart RS-Bpearl, wait for device
connected, open the RSView to check, whether parameters have been changed.

PCIP: -
MSOP Port:
Mac: 0o = le
Serial Number:

Return Mode:
FOV(Deg):

Phase Lock: 0

Bot. FW. Version:

Top F'W. Version:

* Month:
Minute:

Year: 17

Howr: 1

DIFOP Port:
la
161190304877
Azinmith Calibration(Deg):
to
Rotation Speed:

(i) 0z
Oa la
1

53

Get

| [set LiDAR|

Figure C-15: Set LiDAR information.
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information X

Io"_""-l Set LiDAR Successful! Please re-power on the
¥ LiDAR!

Figure C — 16: Set LiDAR information successful.

Note 1: during the process of parameter setting, please not cut off the power supply.
Otherwise, the internal parameters in LIDAR will be incorrectly saved.

Note 2: if the MSOP Port or the DIFOP Port is modified, please set the Data Port in
RSView first according to following section C.8 before reconnecting device.

C.8 Setting RSView Data Port

The MSOP Port by default is 6699, and the DIFOP Port is 7788. If one of the two
parameters or both of them has been changed (just like the description in section C-7), the
new Data Port in RSView must be set and refreshed. Otherwise, the data won’t be
displayed. If the MSOP Port and DIFOP Port in RS-Bpearl are unknown or forgotten, user
can utilize the software Wireshark to capture the data packet from Dst Port.

Click Tools > Data Port, type the MSOP Port and the DIFOP Port changed, then click Set
Data Port.

@ Data Port Setting = -|':-2-3_|
Current MSOP Port:  |6892 Current DIFOP Port:  |T783
New MSOP Port: 9966 New DIFOP Port: 57T

LS&E Data Poﬂ]

Figure C-17: Set Data Port.

C.9 Firmware Update Online

Please ensure the connectivity of LIDAR, and point cloud can be displayed and get the
firmware information according to section C.8.

Click Tools > Online Update, as shown in Figure C-18, top board update and bottom board
update could be selected.

Top Board Update

Eottom Board Update

Config Update

Figure C-18: Online Update.
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For example, click Bottom Board Update, then choose the proper firmware file with suffix
“.rpd”, then click open, start Bottom Board Update. The update process will take a while,
after update “Online Update Successful” will be shown in a message box.

Note: Config Updata is not available.

. @ Select Update File
@.\jﬂ « PLIRSLIDARI » =SB » B7R14

HiE v FETHE

E=E 4 =%
M mEsEnEE || B7R14V2_A2 M2_150Kjic
|| B7R14VZ A2 M2_150K 132 jic
- = |7 ] B7R18V3_AZ M2_120K]ic
55 Subversion B7RI4VZ A2 M2 150Kic
B wn [V err14vz Aspd
[=If=ias | | B7R14V7_Fjic
=l BE T
%
& E
& #ums ()
o FTADE (D)
CaFEE) - . d
SCHE(N): BIRIAVT Aspd - [AllFiles ¢ -

[ mro || m |

Figure C-19: select update firmware.

Y]
—p
b

OK

Figure C-20: Online Update successfully.

C.10 Troubleshooting by Fault Diagnosis

Firstly, need to check connectivity of RS-Bpearl, point cloud can be displayed normally
and the Firmware information (as shown in section C.8) can be got.
Click Tools > Fault Diagnosis, Fault diagnosis window will be shown. Click “Start”
button, the conformance of RS-Bpearl can be real-time monitored, the parameter
including current, voltage, temperature, Uart Baund Error and so on.
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7] x
Operation Status Fault Diagnosis
Crtott Termpepuboe Checkout Bit
Idatl: 1019.01 temperaturc?: 46.25 e 0
A 704.512 temperature?: 44875
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Viat 12V M- 119019 temperatureS: 43.25 manc_euf pee| 0.000%
Vdat 5V 4 98047
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Vdat 1V2: 119995 1 o
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GPS_ ST 0=0
[ stat || stop || Clear |

Figure C-21: Fault Diagnosis Dialogue.
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Appendix D RS-Bpearl ROS Package

This appendix describes how to use Ubuntu + ROS to acquiring and visualizing the
measuring data from RS-Bpearl.

D.1 Software Installation

1. Download and Install Ubuntu 16.04 OS.
2. Please refer the link (http://wiki.ros.org/kinetic/Installation) to install the ROS Kinetic.
3. Download and install libpcap-dev.

D.2 Compile RS-Bpearl ROS Package

1. Create a workspace for ROS:

cd ~

imkdir -p catkin_ws/src

2. Copy the corresponding ros_rslidar_package into the ROS workspace under the path:
~/catkin_ws/src. The latest ros rslidar driver can be downloaded from
https://github.com/RoboSense-LiDAR/ros_rslidar or contact Robosense support.

3. Build:

icd ~/catkin_ws

catkin_make

4. Place the configuration file of corresponding LiDAR into PC:

5. At present, configuration files have been written in LiDAR. If not, use the configuration
files by default in ROS-Driver. Meanwhile, update the parameter in launch file. This path of
launch file can be customized.

6. For example: rslidar_pointcloud/data/rs_Bpearl

7. Note: If user needs to modify the code, relevant code files could not be read.

D.3 Configure PC IP address

For the default RS-Bpearl firmware, static IP address of PC is configured to
“192.168.1.102”, submask: “255.255.255.0”, gateway doesn’t need to configure.
After configuring the static IP, it can be examined in CMD with code ifconfig.

D.4 Display of the real-time data

1. Connect the RS-Bpearl to PC via twister pair wire with RJ45 connector, power on it,
then wait for PC cognizing LiDAR.

2. An example launch file has been provided under path: rslidar_pointcloud/launch, in
order to starting the node that can be run to visualize the real-time point cloud data. Open
a terminal with a location as shown as below:

cd ~/catkin_ws

lsource devel/setup.bash

roslaunch rslidar_pointcloud rs_Bpearl.launch
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3. Open a new terminal:

‘rviz

bk

AT Elapad: | £e3200 Wiall Tisse

tabe. MIAdln-Click: b ¥ 1 ight-Click:: Mern . ShiFE 1

Figure D - 1. Display point cloud Data in Rviz.

D.5 Offline Display the recorded PCAP File

The ros_rslidar ROS package can be also use to display the recorded. Pcap offline data.

1. Modify the “rs_Bpearl.launch’ file like below (please pay attention to the red codeline):
<launch>

<arg name="model" default="RS-BPearl" />
<arg name="device_ip" default="192.168.1.200" />
<arg name="msop_port" default="6699" />
<arg name="difop_port" default="7788" />

<arg name="lidar_param_path" default="S(find rslidar_pointcloud)/data/rs_lidar_Bpearl/"/>

<node name="rslidar_node" pkg="rslidar_driver" type="rslidar_node" output="screen" >
<param name="model" value="S(arg model)"/>
<param name="device_ip" value="S(arg device_ip)" />
<param name="msop_port" value="$(arg msop_port)" />
<param name="difop_port" value="S(arg difop_port)"/>
<param name="pcap" value="75/7.pcap HIZEXT]EELE"/>

</node>

<node name="cloud_node" pkg="rslidar_pointcloud" type="cloud_node" output="screen" >
<param name="model" value="S(arg model)"/>
<param name="curves_path" value="5(arg lidar_param_path)/curves.csv" />

<param name="angle_path" value="S(arg lidar_param_path)/angle.csv" />

<param name="channel_path" value="S(arg lidar_param_path)/ChannelNum.csv" />
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</node>

<node name="rviz" pkg="rviz" type="rviz" args="-d S(find rslidar_pointcloud)/rviz_cfg/rslidar.rviz" />

</launch>

2. Open a terminal, run the node:
cd ~/catkin_ws

lsource devel/setup.bash

roslaunch rslidar_pointcloud rs_lidar_Bpearl.launch

3. This step is same as step 3 in section C.4.
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Appendix E Dimension
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Figure E - 1. Dimension Drawing of RS-LiDAR-Bpearl.
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Appendix F Suggestion of Mechanical LiDAR Mount

Please make sure the surface of platform used for mounting LiDAR is smooth as possible.
Please make sure the locating pin on the mount surface do exceed 4mm high. The
material of the mount platform is suggested to be aluminum alloy in order to thermolysis.
When the LIiDAR is installed, if there is a mounting contact surface on the upper and
bottom sides of the LIDAR, make sure that the spacing between the mounting surfaces is
greater than the height of the LiDAR to avoid squeezing the LiDAR.

When the LiDAR cable is routed in the mount device, please keep the cable a little slack,
not too tense.
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Appendix G Seek MSOP and DIFOP Port Number

According to the description of chapter 5, MSOP and DISOP are the two protocols can be
sent out by RS-Bpearl. Their content could be parsed from excepted port by wireshark
that is a network protocol analyzer. The port information can be used to set up the Data
Port in RSView.

The steps of wireshark usage to set up the right port number for RSView:

Connect LIiDAR to PC and power supply to it. Open wireshark software, choose the
corresponding Ethernet port, start to capture packet from LIiDAR sending. Type filter
condition “data.data[0:1]==55" into the display filter (Hot key: Ctrl + /). Then the MSOP
packet can be filtered out. The MSOP port number can be checked in info column, as
shown in Figure G-1.

For DIFOP port number checking, all of the steps are same except the step of typing filter
condition with “data.data[0:1]==a5” , as shown in Figure G-2.

Figure G - 1. Wireshark Filtering Out MSOP Port Number.

[A}aata dataln:11==55 | ] - Fikd
Hn.. . Tims Sourcs Deztination Frotocol Length Tnfa
> 1 0.000000 192 .168.1.181 102.168.1.102 UDP 129@ Len=1248
20.001217 102.168.1.181 102.168.1.182 UDP 1200 178151781 Len-1248
3 0.002578 192,168.1.181 192.168.1.1062 UDP 1290 17811781 Len=1248
40.003788 192.168.1.181 192.168.1.162 UDP 1290 178151781 Len-1248
5 .004990 192.168.1.181 192.168.1.102 UDP 1298 178151781 Len=1248
6 0.006017 192,168.1.181 192.168.1.162 UDP 1299 178131781 Len=1248
7 0.007218 192.168.1.181 192.168.1.162 UDP 1290 178131781 Len=1248
8 0.008606 192,168.1.181 192.168.1.162 UDP 1290 178131781 Len=1248

Figure G - 2. Wireshark Filtering Out DIFOP Port Number.
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[Fll éata datalni11==s5 | [X] -] *i
o. T Sowrce Destination Protocol Length Infe

— 59 0.0869440 192.168.1.181 192.168.1.182 LUDP 129 Len=1248

144 @.169413 192.168.1.181 192,168.1.182 UDP 1290 77887788 Len=1248

228 9.270128 192.168.1.181 192,168.1.182 UDP 1290 77887788 Len=1248

312 ©.369404 192.168.1.181 192.168.1.162 UDP 1290 77838-»7788 Len=1248

397 ©.469690 192.168.1.181 192.168.1.102 UDP 1290 77887788 Len=1248

482 ©.570183 192.168.1.181 192.168.1.182 UDP 1290 77887788 Len=1248

565 ©.669489 192.168.1.181 192.168.1.182 UDP 1290 77887788 Len=1248

650 ©.769427 192.168.1.181 192.168.1.162 UDP 12900 778857788 Len=1248

735 @.870670 192.168.1.181 192,168.1.102 UDP 1290 778857788 Len=1248
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Appendix H Clean of LiDAR

H.1 Attention

Before cleaning the RS-LIiDAR, please read through this entire Appendix F. Otherwise,
improper handling can permanently damage it.

When the sensor is used in a harsh environment, it is necessary to clean it in time to keep
its performance.

H.2 Required Materials

(1) Clean microfiber cloths

(2) Mild, liquid dish-washing soap

(3) Spray bottle within warm, clean water
(4) Solution of Isopropyl alcohol

(5) Clean gloves

H.3 Clean Method

If the sensor is just covered by dust, use a clean microfiber cloth with a little isopropyl
alcohol to clean the sensor directly, then dry with another clean microfiber cloth.

If the sensor is caked with mud or bugs, use a spray bottle with clean, warm water to
loosen any debris from it. Do not wipe dirt directly off the sensor. Doing so may abrade the
surface. Then use warm, mildly-soapy water and gently wipe the sensor with a clean
microfiber cloth. Wipe the ring lens gently along the curve of the sensor, not top-to-bottom.
To finish, spray the sensor with clean water to rinse off any remaining soap (if necessary,
use isopropyl alcohol and a clean microfiber cloth to clean any remaining dirt from the
sensor), then dry with another clean microfiber cloth.
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